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PREFACE

Why is it such a pain to create PDFs in QuarkXpress? PDF technology has taken the world by
storm and become so widespread that everyone wants to use it for countless purposes - desktop
publishing in particular. Unfortunately for Quark, PDF technology was created by Adobe, the compa-
ny that makes PageMaker and InDesign. PDFs popularity gave Adobe a huge advantage in this
long-standing rivalry, so I don’t see Adobe sharing its technology with Quark anytime soon. The best
thing you can do is get a copy of the full Adobe Acrobat Suite (not too expensive at $249). 

INTRODUCTION

This book covers creating PDFs in QuarkXpress versions 4 and 5 for those who do and do not have
Adobe Acrobat. Differences between versions 4 and 5 are slight. The big difference you need to
know about is creating a PDF without having the actual Acrobat suite installed is very different from
creating a PDF with access to Acrobat Distiller. 

This book is not an Acrobat tutorial. There are many features in Acrobat itself you can get from
classes and books. It’s a blast to play with no matter what application you use to make your PDFs.
The electronic version of this document has plenty of navigational features to take advantage of. 

HARDWARE & SOFTWARE

Every other book has this section, so I figured mine should too. I used a single-processor 400 MHz
G4 Mac running OS X for my internetting and Acrobating. My beta copy of QuarkXpress 5 and
PhotoShop 6 ran in OS 9 (I rarely use Classic). 

I must admit I also used PhotoShop 6 and 7 as well as Acrobat 5 on plenty of PCs running Windows
98, 2000 and XP. 



In version 4 there are several methods of using QuarkXpress in the PDF creation process.

If you do not have Acrobat, you can …

� Create a PostScript document  that can later be opened in Distiller itself or be saved to an
Adobe Acrobat Distiller Watched Folder by someone who has Adobe Acrobat. 

� Create a PostScript document and use the PDF Online feature at www.adobe.com

If you have Acrobat, you can …

� Use the Create Adobe PDF Xtension under the Utilities menu (version 4)

� Print to Distiller

With the way-cool Xtension, you can pull a couple neat rabbits out of a hat that even Adobe
products can’t do. To do this, download the PDF Filter Xtension from www.quark.com and use
the menu command it places under the Utilities menu.
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ACROBAT DISTILLER JOB OPTIONS

(AKA “CONVERSION SETTINGS”)

QuarkXpress - Creating PDFs
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Quality Setting/Option Size

low screen small

medium print medium

high press large
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CREATE ADOBE PDF ONLINE
http://createpdf.adobe.com

Create Adobe PDF Oline does
not except QuarkXpress files
(surprise!), but they will except
PostScript files no matter
where they came from.

To begin:

1. Sign up
2. Activate it via an email

they send you
3. Go back to the web site

and sign in. 

To convert a file, choose...

1. A file to convert.
2. Optimization settings.
3. Security options.
4. Delivery method.

File types include, MS Office,
graphic file formats, a URL,
PostScript files, InDesign and
other native Adobe files.
Again, I wouldn’t expect them
to start accepting QuarkXpress files any time soon. 

You get your first five free. Non-subscribers are limited to files 100 MB and smaller or 10 min-
utes of processing time per file. Volume subscribers get 15 minutes, priority queueing, tagged
files and more.

http://createpdf.adobe.com


QuarkXpress - Creating PDFs

10

Nikki
Alex

Max

What's a Watched Folder?

When a lot of people need to make a lot 
of PDFs, that leaves a lot of room for 
error. Automating the task saves time 
and consistently maintains accuracy.

Each person, instead of messing with a 
bunch of Job Options or Conversion 
Settings, simply saves a PostScript file 
into the "in" folder of a folder that 
Acrobat Distiller is watching. 

Once Distiller notices the postscript file, 
it checks the instructions (the settings 
file) for that folder and converts it 
accordingly. The PDF file is then sent to 
the "out" folder.

So, instead of wondering if everyone in 
your department is doing something 
different, you need only ensure everyone 
can navigate to a particular folder. Of 
course, you could always buy a 
Superball ticket, too.   

Settings
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Out

Print Job
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Out
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CREATE A POSTSCRIPT DOCUMENT

You may want to create a PostScript document for three reasons: 

1. Because you have to send it to someone else who does have Acrobat Distiller.
2. To save it to an Acrobat Distiller Watched Folder.
3. To use Adobe’s PDF Online feature.

You must have a PostScript printer or PostScript Printer Driver to do this!

TO SAVE A FILE AS A POSTSCRIPT FILE:

1. File > Print

This opens the Print dialog containing the following tabs:

�Document
�Setup
�Output
�Options
�Preview

It also contains the “Printer” button. Before we go to the essential “Printer” window, let’s  go
through at least a couple of the tabs in this one.

Document: QuarkXpress is the only appli-
cation (including Adobe products!) that
divides the document into color separations
before sending it to PostScript or PDF. Just
check the “Separations” box and marvel at
your bad self.

QuarkXpress 4 - Creating PDFs
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Output: Here’s another place to look if
your color isn’t coming out as you’d like -
the default for “Print Colors” under the
Output tab is set to, again, Black and
White. Watch out: unless you’ve already
changed the Printer Description under the
Setup tab, you’ll be unable to change this
one. 

For most jobs, the defaults under the
Options and Preview tabs should be fine.

Setup: Even if you don’t want color sepa-
rations, you’d probably like some color,
right? One of the most Frequently Asked
Questions in my classes is “Why do my
PDFs from QuarkXpress come out in
Black and White?” As you can see from
the screen shot, “Generic B&W” is the
default setting for “Printer Description”
under the Print window’s Setup tab.
Simply choose “Generic CMYK,” for
instance, and your PDF will be as colorful
as your personality.
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2. Click the “Printer...” button

After making sure
the settings in the
Print window are
what you want, click
on the “Printer...”
button at the bottom.
This takes you to the
Printer window, which
is where you tell
QuarkXpress you want
a PostScript file (as
opposed to a PDF or
traditional hard copy).

To generate a PostScript
file, change the
“Destination” menu in
the upper right corner to
“File.” This will change
the “Print” button to a
“Save” button.

While you’re here,
you can also
check a few
other settings.
Below the
Printer menu
you should see
a menu display-
ing “General.”
Click on that
menu to view the
“Font Settings.”
Anytime you have
the opportunity to
embed or download fonts, you should.

Under that same
menu, select “Save as
File.” You should
change the “Data
Format” to “Binary.”
ASCII is the default,
which would make
a larger than nec-
essary file size.  

Once finished,
click “Save” in the lower

right. You’ll then name and Save
the file. If you are

using
Acrobat’s
Watched
Folder system,
you would
choose the In
Folder inside the
Watched Folder
here. 

After you’ve
clicked “Save,”
you’ll be back in

the original Print window.
Select “print” and this will
save a PostScript copy of
your document.

QuarkXpress 4 - Creating PDFs

8



11

QuarkXpress 4 - Creating PDFs

USING THE PDF FILTER XTENSION IN VERSION 4

SET UP

Check out your PDF Export settings under the Edit > Preferences menu. These are document
specific and contain things like Document Info, hyperlinks and bookmarks options, Job
Options, and Output. Under "output" you can choose to have QuarkXpress create color sepa-
rations.

Check out the settings in the PDF tab of your Application Preferences. Here you tell Xpress
where to find Distiller and, under "Workflow," whether or not to create a PostScript file or a
PDF file. Why would you choose to create a PostScript file instead of going directly to PDF?
Because you may (and it's a good idea) be using a Watched Folder that is set up in Acrobat

Distiller.

Utilities > Export as PDF

Click on “Preferences.” PDF
Export Preferences control
what features your resulting
PDF will have. 
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Document Info

You may be used to skipping past
any document information boxes,
but when creating a PDF, take the
time to fill them out. You’ll be glad
you did if you plan to create a
searchable index for your PDFs
with Acrobat Catalog.

Hyperlinks

You can create hyperlinks and
bookmarks in your PDF based on
Style Sheets (yet another reason to
use Style Sheets!)
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Job Options

Here you have several important
choices such as whether or not to
override Distiller’s Job Options.

Output

If you’d like to create color separations,
you can choose to do so here.



QuarkXpress 4 - Creating PDFs

14

PRINTING TO DISTILLER

If you have Adobe Acrobat,  you can print to
Acrobat Distiller.

Neither QuarkXpress 4 nor 5 is native to Mac
OS X, so Printing to Distiller differs significantly
between a machine running a Mac OS and
Windows. 

In the Macs “classic” mode or plain-old OS 9,
you must choose your printer in the Chooser. A

PostScript printer driver such as AdobePS (available as a free download from Adobe’s web
site) will enable you to Print using Distiller.

1. File > Print

This opens the Print dialog containing the following
tabs:

�Document
�Setup
�Output
�Options
�Preview

It also contains the “Printer” button. Before we go to
the essential “Printer” window, let’s  go through at
least a couple of the tabs in this one.
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Document: QuarkXpress is the only appli-
cation (including Adobe products!) that
divides the document into color separa-
tions before sending it to PostScript or
PDF. Just check the “Separations” box and
marvel at your bad self.

My advice is to make sure “Thumbnails” is
deselected. Acrobat Reader 5 generates
thumbnails automatically, so there’s no
need to waste file space by embedding
them.

What if they’re using version 4? My humble opinion is that if they’re too intimidated to down-
load an upgrade to a piece of free software, they won’t be looking for anything so technologi-
cally advanced as thumbnails.

Setup: Even if you don’t want color sepa-
rations, you’d probably like some color,
right? 

One of the most Frequently Asked
Questions in my classes is “Why do my
PDFs from QuarkXpress come out in
Black and White?” As you can see from
the screen shot, “Generic B&W” is the
default setting for “Printer Description”
under the Print window’s Setup tab.
Simply choose “Acrobat Distiller” and your
PDF will be as colorful as your personality.
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Options: You may want to make sure
“Data” (May he rest in peace) is set to
Binary instead of ASCII and I would check
off “Full Resolution TIFF Output” to ensure
you don’t get a substandard on-screen
preview version in your PDF document. 

Click the “Printer...” button

After configuring the settings in the Print
window as you desire, click on the
“Printer...” button. 

After telling this box to never, ever bother
you again, you’ll be taken to the Printer
window, which is where you tell
QuarkXpress you want a PDF as opposed
to a hard copy.

To generate a PDF, change the “Printer” menu
in the upper left corner to “Acrobat PDF,”
“Create Adobe PDF,” or “Virtual Printer.” The

Output: Here’s another place to look if
your color isn’t coming out as you’d like -
the default for “Print Colors” under the
Output tab is set to, again, Black and
White. Watch out: unless you’ve already
changed the Printer Description under the
Setup tab, you’ll be unable to change this
one. 

For most jobs, the defaults under the
Options and Preview tabs should be fine.
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button in the lower right will change to “Print”
for the first choice and “Save” for the sec-
ond and third choices. You may not have all
three options.

The Advantage to “Create Adobe PDF” is
you get the Job Options menu where you
can choose any of the default settings or
any custom settings you’ve configured

and saved some place else.

While
you’re here, you can also

check a few other settings. Below the
Printer menu you should see a menu dis-
playing “General.” Click on that menu to
view the “Font Settings.” There is an
option for downloading fonts. 

Anytime you have the opportunity
to embed or download fonts, you should.

Since it will be saving a new file, give it a
name. It can be the same name as the
QuarkXpress file.

Since you are "printing" to a virtual printer
(Distiller), you can choose which pages will
be converted ("printed").

You can click "preferences" to change the
default Export Preferences. 

Always check your fonts… make sure they
will be embedded.

Click save.
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OTHER RESOURCES FROM SPROUTGRAPHICS

http://www.sproutgraphics.com/acrobat/acrobat.html
http://www.sproutgraphics.com
http://www.sproutgraphics.com/quark/quark.html
http://www.sproutgraphics.com/quark/quark.html
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OTHER RECOMMENDED RESOURCES

Create a PDF from QuarkXpress
www.mimag.com/pdf/qpdf.html
An up-to-date guide for Mac users printing to Distiller based on Mac OS 9.2.1 and Xpress 5. 
You can email the author at kippy@mimag.com

Recommendations for Creating PDF Files from QuarkXpress in Windows
www.adobe.com/support/techdocs/1593e.html

Recommendations for Creating PDF Files from QuarkXpress in Mac OS
www.adobe.com/support/techdocs/1cd72.html

Adobe Acrobat 5 Master Class by Pattie Belle Hastings, Bjorn Akelsen and Sandee Cohen

PDF Printing and Workflow by Frank J. Romano

The Acrobat Bible by Ted Padova

studio.adobe.com
Adobe’s outstanding “Expert Center” with tons of free tutorials

www.planetpdf.com

www.pdfzone.com

Creating Adobe Acrobat Forms by Ted Padova

Adobe Acrobat Classroom In A Book

www.mimag.com/pdf/qpdf.html
mailto:kippy@mimag.com
www.adobe.com/support/techdocs/1593e.html
www.adobe.com/support/techdocs/1cd72.html
http://studio.adobe.com
http://www.planetpdf.com
http://www.pdfzone.com
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